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OneCNC Lathe is a hybrid CAD-CAM system with a user-friendly 
interface.  OneCNC Lathe simplifies the process of designing and 
machining parts using CNC lathes and multi-axis turning centers.

OneCNC integrates the Microsoft Windows interface with a powerful 
CAD engine.  Parts can be designed and modeled in OneCNC, or 
imported from 2D or 3D CAD files.  The part model and geometry 
data is directly available to the inbuilt CAM functions.

The purpose of this Manual
This manual covers OneCNC Lathe Expert, Professional, and Express.  
The manual provides information on how to get started and use 
OneCNC, it is not designed as a machining instruction manual.

Much of the information in this manual is also contained in the 
OneCNC Help file, which also contains tutorials and reference 
information about available procedures and commands.

OneCNC Lathe
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OneCNC Environment

OneCNC has been designed as an integrated manufacturing 
environment, with purpose built interaction between the CAD and 
CAM functions.

New users familiar with Windows-based software will be at home 
with the well organized pull-down menus, toolbox and shortcut keys 
together with meaningful graphics included throughout the software 
interface.

The interface is similar to other common Windows-based drawing 
software and provides compact access to frequently used functions.  
Users experienced with other mechanical CAD software will appreciate 
the ability to customize the functionality in a way they are used to 
using.

CAD functions
The CAD functions are used to draw and create parts.
Line, arc, and spline geometry can be combined with NURBS surfaces 
and solids in a hybrid modeling process.  As well as the complete CAD 
functions for constructing parts from scratch, robust translators are 
provided for importing parts in other formats.  2D drawing and 3D 
modeling methods have been designed for ease of use.

CAM functions
The CAM functions are used to create the required NC program 
toolpaths for CNC machining of your parts.  Toolpaths can be edited 
and reviewed in the NC Manager, which also has functions for 
backplot, real time preview, and metal removal simulation.

Multiple Views
OneCNC can show single or multiple views of the same object or 
model.  Any view can be dynamically panned, rotated or zoomed.  
Multiple views make it easier for you to create complex models.  While 
in a command it is possible to select a point in one view and then 
select the next point from another view.

Multiple Document
You can have more than one part drawing open in OneCNC. This 
makes it easy to cut and paste from one drawing to another and 
toggle between drawings.  The Recent File tab shows previews of 
files to help you quickly find the drawing you want.  Document 
management is simple in OneCNC due to the fact that the CAM data is 
stored in the drawing file.
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OneCNC Installation

Minimum System Requirements

Operating System
Microsoft Windows 10, 8, 7, Vista or Windows XP (32 or 64bit)
Internet Explorer 7 or later
NTFS File System is recommended

Hardware 
Minimum 1 GB of quality memory for Windows XP, or 3 GB of quality 
memory for Windows 8, 7, or Vista, especially if working with complex 
parts.

Pentium 4 single, dual, or quad core PC.  AMD Athlon can be used 
only if later than 2004 with specs equal to the Pentium 4.

NVIDIA GeForce or similar OpenGL and DirectX graphics card, 
minimum 1Gb.  It is essential you download and install the latest 
graphics driver for your card, as drivers supplied on install discs may 
be outdated due to production lead times.

A mouse with 3 or more buttons and a scroll wheel.
One available USB 1.1 or 2.0 port or a suitable parallel port depending 
on which licensing dongle you have.
CD-ROM drive for installation of standalone version if required.
Broadband Internet access is recommended for updating the 
software.

OneCNC Installation

You will need:
OneCNC installer disk or a downloaded update setup file
OneCNC dongle
CD Key and serial number

There are three steps to installing OneCNC on a single computer:
Install the software from disk or an update setup file
Plug in the dongle
Run OneCNC and enter the serial number to activate it

For network installations, network server software must be installed 
as well.  That process is outlined in the next chapter.
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All OneCNC products can be installed from the one installer package.

Insert the OneCNC CD or plug in the OneCNC flash drive. 
Display the drive contents in Windows Explorer and double click 
‘onecnc_setup.exe’

Language Selection
Select your language from the drop down list.

Units Selection
Select the units you work in, Metric or Imperial (inches).  This will set 
the default drawing units and post-processor configuration units.  The 
units setting can be changed after installation using the Properties 
dialog on the File menu.
One CNC will open a file drawn in the alternate units at the correct 
real world size, but the NC toolpaths will be invalid, so you should 
save the files to separate locations.

CD Key
OneCNC installation requires a CD Key, which is usually found on 
the inside rear cover of this manual with your serial number, but is 
sometimes shipped separately from the software for security.
Enter the CD Key and click the large ‘play’ button to start the 
installation.  

The serial number will be requested when you first run the software.    
Keep a copy of your CD Key and Serial in a safe place as you will 
need them if you upgrade your computer and need to re-install.
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The next dialog advises you to have all other programs closed, which 
is standard software installation procedure.

You then have the choice of where to install OneCNC.  You can accept 
the default location or click the Browse button if you want to select 
your own location.  Click Next when you are ready to continue.

In the confirmation dialog you can click Back to review your settings, 
or click Next to install OneCNC.

If you are upgrading from a previous version of OneCNC, the new 
installation will be in a new location.

You can still use your existing tool and material libraries, and 
custom Posts.  To do this, copy the Settings folder from your 
previous installation to your new installation Settings location.

It is good practice to keep a backup copy of your Settings folder.
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OneCNC Updates

Registered users can download updates of the setup file for their 
version of OneCNC at no extra charge.

Go to http://onecncsupport.com/ and click on OneCNC Updates 
when you have read the update details.
Click on Check For Updates.

Enter your dongle and serial numbers to enter the site.  Click on the 
Register button on the next page to appear.  Fill in your registration 
details, and click Save.  Click on the Download button to go to the 
actual download page.

Select the check box to confirm you have read the update details, 
and click on the Download button.  A dialog will appear asking if you 
want to Run or Save the file.  Select Save and choose the folder on 
your computer to save the file in.  Double click the downloaded file 
to install the update.

The update can also be accessed by clicking on OneCNC Updates in 
the Help menu, or the OneCNC Software Updates, Drivers and Posts 
link in the OneCNC Users Forum.

When all the files have been installed, click Finished to complete the 
installation.  There will be a pause while the dongle driver for Series 1 
dongles is installed.

When the installer closes, you are ready to insert the dongle and start 
OneCNC.
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Dongle Installation

OneCNC requires a dongle for the licensed program to run.
A dongle is a small hardware device which verifies your software 
license.

Series 2 Dongle Installation - dongle numbers from 10000

All OneCNC dongles with a number higher than 10000 are Series 2 
dongles.  

Series 2 dongles are USB HID devices which look like this.  These 
dongles do not require drivers for a single computer installation.

If you have a network license you will need to install a network dongle 
driver, as described in the next chapter.

To install a Series 2 dongle
Make sure OneCNC is not loaded or attempting to load.  To install the 
dongle simply plug it into a USB port on your computer.  Basically, if 
the dongle fits, it’s the correct port. Do not try to force the hardware 
or you may damage your computer or dongle.

If you have a timed licence the Windows date and time must be 
correct before connecting the dongle.  It is recommended that the 
USB port a dongle is plugged into should not be used for other 
devices.

Dongle Security

Because it is the dongle which verifies your purchase of OneCNC, 
if a dongle is accidentally damaged or broken the damaged dongle 
must be returned to OneCNC before a replacement dongle can be 
issued.

If a dongle is lost or stolen, the replacement price is the full price 
for the software.  Take steps to secure your dongle, and insure it for 
the replacement cost of the software.
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Series 1 Dongles - dongle numbers 1 to 9999

If you have upgraded from an earlier version of OneCNC, you may 
have a Series 1 dongle with a number less than 10000.

These dongles may be USB or Parallel port dongles, and are now 
obsolete.

There is no 64 bit driver available for these older dongles, so if 
you have a series 1 dongle please see your OneCNC dealer for a 
replacement series 2 dongle.

A series 1 dongle will be replaced at no extra cost with any upgrade to 
the current version of OneCNC.

Note: 
 
A series 1 dongle will not run the 64bit version of OneCNC.

Until you get your replacement dongle you can install the 32bit 
version of OneCNC on 64bit Windows by changing the last two digits 
of the CD Key to 32.  For example the CD Key 6432 will install 32bit 
Mill Express which can be run with a series 1 dongle.

When you change to a new series dongle re-install OneCNC with the 
standard CD Key.
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Network licence - Series 2 dongle

To run OneCNC on a client PC connected to a network using a Series 
2 dongle, you must select ‘Network licence’.

To run OneCNC on a computer which is also the network server, the 
server installation needs to be set to ‘Single user licence’, as in this 
case the dongle is on the local system and not on the network.

Start OneCNC and enter the Serial Key

Once installation is complete and the dongle is installed, OneCNC can 
be started.  Double click on the OneCNC shortcut on your desktop, or 
select the OneCNC shortcut in the OneCNC folder in the Start menu.

The first time OneCNC is started the Licence Manager will look for 
the dongle.  Select ‘Single user licence’ if you have a standalone 
installation, and click Continue.
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The Licence Manager will open so you can enter the licensed user 
name and serial number.

The serial is made up of digits 0 to 9 and letters from A to F.  The 
code must be entered exactly as it appears.

When the serial key has been entered the Licence Manager will 
indicate that the licence is acceptable, and the software can then be 
started.

Entering serials for optional modules

If you have a serial for an optional module, 
start OneCNC and click on Register Modules in 
the OneCNC Help menu.

Enter the serial in the dialog which opens, and 
the module will be activated.
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User profile selection

OneCNC starts with this screen, which gives you the option of 
selecting the user profile you want to use.  The user profile stores all 
your settings such as toolbar layout, interface color settings and your 
recent files list.

Clicking on the small arrow opens the user selection dialog, which 
allows you to select or create settings in the names of specific users 
for customizing.
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Select the user profile you want to 
use from the list, and click OK.

You can create, delete, and 
rename user profiles using the 
buttons below the drop down list.

Click here to start OneCNC 
with the selected user 
profile.

If your user profile or other settings are not being saved, open 
Windows Explorer and right click on your Settings folder.  Select 
Properties, and clear the “Read-only” check box.  Click Apply and 
click OK to apply the change to all subfolders and files.
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This step is only necessary for network installations.

For network installations, network server software must be installed 
on the server or computer the dongle is plugged into.

Series 2 dongles use the OneCNC Dongle Server which is included in 
the OneCNC installer, and is accessed by a CD Key similar to installing 
the OneCNC software itself.  

To install OneCNC Dongle Server on a computer or server with a 
Series 2 dongle, you will need: 

•	 OneCNC installer disk or a downloaded update setup file
•	 OneCNC dongle
•	 Network CD Key and serial number

OneCNC Network Installation
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Run the installer on the server computer.  To install the network 
dongle server software enter the CD Key 60200.

When the next dialog appears, enter the server software serial.  The 
serial is made up of digits 0 to 9 and letters from A to F.
This is not the same as the software serials which are entered later 
when installing the particular versions of OneCNC such as Mill and 
Lathe.
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The next dialog advises you to have all other programs closed, which 
is standard software installation procedure.

You then have the choice of where to install the server software, the 
default installation is as shown.
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The next dialog indicates you will need to unblock the firewall for this 
application only.  Click Finish to complete the installation.

Here is the Windows Firewall dialog where you have to click Unblock 
for the dongle server software to work.  This has no effect on network 
or internet security, it is only allowing any PC on the local network to 
access the OneCNC Dongle Server.



Page 20 Introduction to OneCNC ©

The server software is now installed and working.

There will now be an icon in the Taskbar at the bottom of your screen, 
indicating the dongle server software is running.

You can click the icon to open the Dongle Server interface, but it is 
not necessary to have the Dongle Server interface open for client 
computers to access the dongle.

The interface allows you to see how many clients are connected to the 
Dongle Server.  You will not see a connection as shown here, until the 
OneCNC programs are installed on the client computers.

To install OneCNC on the client computers, start the OneCNC installer 
on each computer, and load the OneCNC application using the CD key 
for OneCNC.
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Running OneCNC Dongle Server automatically

You can run OneCNC Dongle Server automatically so you do not have 
to start it if the server has been shut down.
Setting up a scheduled task will install OneCNC Dongle Server as a 
service which will automatically restart when the network server is 
started.

Firstly, install OneCNC Dongle Server as shown in the previous 
section.  You can then use the Windows task scheduler to set up 
an action to start the OneCNC Dongle Server when the computer is 
started.  You must be logged on as an administrator to perform these 
steps.

To open the Windows Task Scheduler, open Control Panel, click on 
System and Security, and click on Administrative Tools (if Control 
Panel opens in Classic view you can just double click on Administrative 
Tools). Double click on Task Scheduler.

In Windows Server, open the Server Manager and navigate to Server 
Manager > Configuration > Task Scheduler .

Click Create Basic Task.  Enter the name and description for the task, 
and then click Next.  Select When the computer starts, and click Next.  
Select Start a program, and click Next.  Click Browse to find the 
OneCNC server program, which will typically be at C:\OneCNC Server\
onecnc_server.exe  Click Next when you have selected the program. 
Review the settings you have made and click Finish.

Restart the server to apply the changes you have made.
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The OneCNC user interface has been carefully designed for ease of 
use.

Windows menus give you access to many features in OneCNC.  Menu 
items with a pointer on the right side automatically open sub-menus 
which you can slide the mouse across to select from.

OneCNC User Interface 

The Mill Expert interface is shown in this chapter.  The available 
modeling and CAM functions you see will vary for different types or 
levels of OneCNC.  OneCNC Solid Creator is intended for design only 
and has no CAM functions.
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Drawing Window 

The file you are working on is displayed in the drawing window, which 
is a real-time OpenGL model view.   This allows you to view your 
object by means of dynamic rotation, panning and zooming. 

Multiple Views of the same file can be shown.  When parts become 
complex it can be useful to view and edit one object from various 
angles simultaneously.  This function can be accessed from Window > 
Window Layout.
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Multi Document

You can have more than one file open in OneCNC.  When the file 
windows are maximized you will only see one file at a time.  You can 
select the file to display from the Window menu.

Clicking the Restore Window button will display each file in 
its own window.

The file windows can be controlled by dragging, or using the Cascade 
and Tile commands on the Window menu.
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Toolbox

The Toolbox is a menu system which is shown in the left sidebar.

When you start OneCNC you will see the toolbox 
Home menu.

The Home menu icons are grouped into 
commands for drawing, modeling, and CAM 
functions.

The toolpath functions available will vary with the 
version and level of OneCNC you are using.

Each icon in the toolbox Home menu will open a 
sub-menu from which you can select a specific 
command.

For many commands entry boxes will appear 
where you can input required values.

Click on the Home icon at the top of the Toolbox 
to return to the Home menu.

Clicking on the dotted button at the left of the toolbox will hide it.

Click on the button again to bring the toolbox back into view.



Page 26 Introduction to OneCNC ©

Right Sidebar

On the right of the screen the right 
sidebar has panels for:

•	 NC manager
•	 Layers Manager
•	 CAD Verify
•	 History
•	 Recent file list

Clicking on the dotted button at the right of the sidebar will hide it.

Click on the button again to bring the sidebar back into view.

NC Manager

The NC Manager displays the 
toolpaths you have defined.

Machining operations can be grouped, 
and operations can be renamed, 
edited, rearranged or duplicated.
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Layer Manager

When you draw an entity it’s created 
on the currently selected layer.  The 
Layer Manager  is used to create, 
name or delete drawing layers.

The panel shows a list of layers in a 
drawing.  You can turn off a layer by 
closing the eye for that layer in the 
Layer Manager.  Entities on the layer 
are still in the drawing but will not be 
visible.

Verify

The Verify panel holds tools to read 
data from geometry.  

You can find exact values for position 
length or area for 2D entities, and 
volume of 3D solids.  You can also 
find the angle and distance between 
entities.

History

As you construct your part, a record 
of commands used is created in the 
History tab.
You can roll construction back or 
forward like a multiple undo and 
redo.  If you roll-back your history 
and start new construction, the rolled 
back construction is replaced with the 
new construction.

Recent Files list

When you save a file, a thumbnail 
image of it is added to the Recent file 
list.
The list shows if a file is open, active 
or closed.
You can open a closed file by clicking 
on the thumbnail image.
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Status Bar

The Status Bar at the bottom of the OneCNC window provides you 
with functions related to the appearance of objects, and a message 
panel which shows prompts to help you use the program.

Preset Views

OneCNC has a set of preset views so you can select the direction you 
want to look at your model from.

Click on the View icon to open the preset view selector.

Click on the icon for the view you would like to 
change to.

For 3D modeling the Isometric or Trimetric Views are 
the most commonly used.

The CAD View is a special view optimized for 2D 
drawing, so it is not suitable for 3D commands.  Use 
the Top View if you want to use 3D commands in a 
view similar to the CAD view.
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Construction Plane

When you draw or model in OneCNC you can use a coordinate system 
which is independent of the world XYZ coordinate system. 
OneCNC displays the Construction Plane which is a visual reference 
for the XY plane of the current construction coordinate system.

The Construction Plane is controlled using the Plane dialog, which 
is opened by the Plane icon in the Status Bar.

The Working With Planes tutorial in this manual covers the use of 
Construction Planes.

Display mode

Display controls the appearance of 3D surfaces and solids. 

Click on the Display icon to open the Display mode selector.

Click on the icon for the display mode you would like 
to change to.

If you are extracting 2D profiles from 3D objects it 
can be useful to use the Transparent or Wireframe 
modes to access obscured parts of the model. 

If you set the display mode to Wireframe, be sure 
to return it to another mode before attempting any 
modeling commands as you will not see any surfaces 
or solids.
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Section Tool

The Section tool is used to view a cross-section of your work 
parallel to the current working plane.  It can also be used to create 
section geometry.

3D to 2D Automated drawing system

In Expert versions of OneCNC and OneCNC Solid Creator you will 
see the Pages icon which opens the automated 3D model to 2D 
CAD drawing system.  This can be added as an optional module to 
OneCNC Professional versions.

Drawing Color and Style selection

OneCNC has a 2 color drawing system.  Color selection boxes 
in the Status Bar set the color for new entities.  The color 
selection box on the left is for geometry and that on the right 
is for surfaces and models.

To select the line style and line thickness for new geometry entities 
click the Styles icon.

Modifying Entities

Click Modify to change the color, line  thickness, line style or layer 
of existing entities.

Select the check boxes for 
the attributes you want to 
change and select the new 
values.
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Quick Access Toolbar

The Quick Access toolbar is a custom toolbar you can use to display 
icons for commands you use often.

When you install OneCNC the Quick Access toolbar will be empty 
except for the Quick Access icon.  Click on the Quick Access icon to 
open the Quick Access customization dialog.

Select the command you want to add in the Commands list on the left 
of the dialog.  A keyboard shortcut can be assigned to the command 
in the ‘Assign hot key’ entry box.

You can right click on an icon you use regularly to add it to the Quick 
Access toolbar.
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Keyboard Shortcuts

OneCNC provides a default set of keyboard shortcuts, which are a 
powerful way of accessing functions quickly by pressing a key or 
combination of keys.  You can add your own keyboard shortcuts in the 
‘Assign hot key’ entry box of the Quick Access dialog.

The following lists give the default shortcut key settings in OneCNC.

View shortcuts
Arrow Keys			   Rotate model horizontally and vertically
Arrow Keys + Shift		  90 Deg steps rotate right left up down
Ctrl + Arrow Keys		  Pan
Space Bar			   Preset View selection dialog
Space Bar double press	 CAD View
Delete			   Delete selected entities
F				    Zoom to fit
Z + Shift			   Zoom in
Z				    Zoom out
W				    Zoom to a window
Ctrl + 1			   Top View
Ctrl + 2			   Bottom View
Ctrl + 3			   Left View
Ctrl + 4			   Right View
Ctrl + 5			   Front View
Ctrl + 6			   Back View
Ctrl + 7			   Isometric View
Ctrl + 8			   Trimetric View
Ctrl + 9			   Dimetric View
Ctrl + 0			   Default View

Drawing shortcuts
P				    Point
L				    Line
R				    Rectangle
O				    Offset
H				    Hatch
C				    Circle with given radius
Ctrl + F			   Fillet Arc
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File shortcuts
Ctrl + N			   New file
Ctrl + O			   Open file
Ctrl + S			   Save file
Ctrl + Tab			   View next open file
Ctrl + P			   Print

Edit and modify shortcuts
S				    Select Single
L				    Select nearest line when in Single Select 
mode
A				    Select nearest arc when in Single Select 
mode
Ctrl + A			   Select All
Ctrl + Z			   Undo
Ctrl + Y			   Redo
Ctrl + X			   Cut to clipboard
Ctrl + C			   Copy to clipboard
Ctrl + V			   Paste from clipboard
Ctrl + D			   Delete
M				    Move
B				    Blank selection
T				    Trim One
Ctrl + T			   Trim Two

Mouse Actions

Left Button			   Enter / Select
Right Button			  Escape / End Function
Mouse Wheel		  Zoom to/from cursor
Middle Button + Ctrl		 Pan
Middle Button		  Rotate view
Middle Button + Shift	 Zoom
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The purpose of OneCNC is to create NC code programs for CNC 
machines.  The workflows for the various types of OneCNC are as 
follows:

OneCNC Mill or Mill with Multi-axis module
1.	 Draw or import part geometry or model
2.	 Define toolpaths to cut the part
3.	 Preview or simulate to verify toolpaths
4.	 Output NC program to send to the machine

OneCNC Lathe
1.	 Draw or import part geometry or model
2.	 Define toolpaths to turn the part
3.	 Preview or simulate to verify toolpaths
4.	 Output NC program to send to the machine

OneCNC Lathe with Mill-Turn module
1.	 Draw or import part geometry or model
2.	 Define turning and live tooling toolpaths
3.	 Preview or simulate to verify toolpaths
4.	 Output NC program to send to the machine

OneCNC WireEDM
1.	 Draw or import part geometry or model
2.	 Define wirepaths to cut the part
3.	 Preview to verify wirepaths
4.	 Output NC program to send to the machine

OneCNC Profiler (Nesting for plasma, laser, waterjet or router)
1.	 Draw or import part geometry
2.	 Add part shapes to the Parts list
3.	 Nest parts to sheets
4.	 Define drill, engrave and cutting operations for the nested sheets
5.	 Preview to verify toolpaths
6.	 Output NC programs to send to the machine

OneCNC Overview 
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2D and 3D Geometry

Geometry drawing
OneCNC parts are constructed using pure geometry.  Boundaries can 
consist of lines, arcs or splines constructed in 3D space.

Layers
The Layer Manager sidebar panel is used to create, select, open and 
close layers which are used to organize your drawing.

Dimensions and Text
All 2D and 3D geometry can be dimensioned and annotated.  
Text labels can be added to parts and converted to geometry for 
engraving.

Drawing Layout Patterns
Borders, title and revision blocks, and bill of material lists can be 
saved as patterns and loaded into drawings as required.

3D to 2D Technical Drawing System
Expert versions of OneCNC include the 3D to 2D drawing system 
which automates the preparation of 2D drawings for printing.  2D 
technical drawings are created as page layouts in your ONECNC file, 
using title block and border templates.  2D views of the 3D part model 
can be created automatically and added to a technical drawing.
The system can be added to Professional versions of OneCNC as an 
optional module.
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3D Modeling

Available in OneCNC Expert and Professional versions

Surfaces Creation
Planar and curved surfaces can be constructed using the many 
available strategies.

Solids Creation
Solids creation from Primitives allows you to create basic shapes such 
as Cubes, Spheres, and Cylinders.  Solids can also be created by 
revolving or extruding geometry.

Hybrid Solids Creation
In the hybrid modeling technique a closed set of surfaces can be 
unioned to become a new solid.  Existing solids can be merged with a 
closed set of surfaces to become a new solid.

Model Operations
New solids can be created by the cutting, uniting or intersection of 
existing solids.  Solids can be split by a plane, or broken into separate 
surfaces.

Expert Tools
Expert versions of OneCNC have additional advanced modeling tools.
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Toolpathing

In all versions of OneCNC except Solid Creator, toolpaths can be 
defined by clicking an icon in a Toolpaths menu in the Toolbox and 
completing any selection or settings entries that the toolpath requires.  

Toolpath management

When you define a toolpath it will be 
added to the active toolpath group in 
the NC Manager.

An NC file can be output from a single 
operation, all the operations in a 
single group, or all operations in all 
groups in the NC Manager.

Right clicking on a group or toolpath 
will open a context menu with 
commands for frequently used 
functions such as preview and 
backplotting.

In Mill or Lathe the lower section of 
the NC Manager displays settings for 
the currently selected toolpath which 
can be edited.

Toolpath Backplot

Toolpaths can be backplotted, which means they are drawn as 
geometry on a special layer named Backplot.  Feed moves are drawn 
in green, and rapid moves in orange.  Reposition moves in highspeed 
machining are drawn in blue.
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Toolpath Preview

The Live Preview window shows an animated preview of the toolpath, 
backplotting as it goes.  In Mill or Lathe the cutting tool will be shown 
traveling along the toolpath.

Metal Removal Simulation (OneCNC Mill and OneCNC Lathe only)

In all levels of Mill and Lathe, OneCNC provides real-time toolpath 
metal removal simulation.  By simulating the feed and speed of the 
process, you can check the machining operation prior to sending to 
the CNC machine.

OneCNC Mill also provides Rest Material Verification, which highlights 
the thickness of material left on the part until it is fully machined.
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Outputting NC Files

Clicking the Process icon in the NC Manager opens the NC Processing 
dialog.  You can enter notes or a program number before the file 
is output.  OneCNC formats the NC file using a machine specific 
definition called a ‘Post’.  OneCNC is supplied with Posts for all popular 
machines, and it is easy to create a custom Post by copying and 
editing an existing format.

Editing  and sending the created program
When you output the NC file for your job it will open in OneCNC Link, 
the complete editor and DNC transfer program, where you can see 
your NC code before the final stage of sending the completed NC 
program to the CNC machine.
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OneCNC Integrated Help 

At OneCNC we put a lot of effort into making OneCNC the world’s 
easiest CAD/CAM package to use.  OneCNC has several features 
within the program to help new users quickly adapt to its powerful but 
easy to use features.

Help

If there is a specific part of the program you 
want to learn about, click on Contents in the 
Help menu.

The help files will open in a new window, 
with navigation controls at the top.
The Back or Forward buttons allow navigation 
between help files you have visited, like 
an internet browser.  The Home button will 
return you to the first page shown on the 
screen. 

Tutorials

Clicking on Tutorial in the Help menu will 
take you straight to the OneCNC Tutorials 
folder in the Help files.

There are step by step tutorials for 2D CAD, 
3D modeling, and how to define machining 
toolpaths for each version of OneCNC. 

Context Sensitive Help
OneCNC uses Context Sensitive help.  This means if you are using 
a function and need help on it, press F1 and OneCNC Help will open 
showing the relevant topic.
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OneCNC CAD Tutorial 1
Introduction To Cad Drawing

This Tutorial is designed for all OneCNC products.

This tutorial will quickly take you through the essential functions for 
drawing and modifying geometry in OneCNC, to get you up to speed 
in the shortest possible time.  In the exercises in this chapter, exact 
positioning is not important.  The aim is to get an overall view of the 
process of drawing in OneCNC.

Start a new drawing

When you start OneCNC you will have a new file ready to draw in.

You can also start a new file by clicking on the New File icon in the 
Standard toolbar.

The first thing you should do when starting work in a new file is 
to click Save and save the .ONECNC file.  If you save this tutorial 
you will be able to open it and resume where you left off if you are 
interrupted.

It is good practice to save your file regularly as you work.  When 
working on complex parts, you can use the Save As command on 
the File menu to make incremental copies of your work, saving as 
“file_01.ONECNC”, “file_02.ONECNC”, and so on.

It is strongly recommended that you save a backup of all your work 
in another location once a day, and in an offsite location every 
week.
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The part will open in the default 3D view.  The darker rectangle is the 
construction Plane, which indicates the XY plane of the coordinate 
system you will be drawing in.  Later you will see how you can move 
and rotate the Plane to define a new coordinate system but for now 
we will leave it in the default XY position.

Lines

We will start with lines, the most common drawing entity.

Click on the Line icon to open the Line menu in the toolbox.

The Line icon in the Line menu is highlighted, 
showing that the Line command is started 
automatically.

When the Line command is active, coordinate 
entry boxes will be available in the toolbox.  
Coordinate entry can be used for the first or 
second point of any line segment.

You can enter coordinates for a position in the 
World coordinate system, or the coordinate 
system of the current plane.

The current mouse pointer position is 
displayed in the toolbox, so you can also use it 
to check the position for a grid snap. 
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The mouse pointer will snap to grid positions in the drawing plane.
Click to select a start point for the new line.

The mouse pointer will have a preview of the line to be drawn 
attached to it.  Click on a new grid point to draw a horizontal line.

The Line command draws consecutive lines.  Click again to draw a 
vertical line from the last point.
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Move the mouse pointer horizontally again and you will see an 
indicator line when the new line endpoint is aligned with the start 
position.  Click to end the line on the vertical alignment.

Hold the mouse pointer near the start of the chain of lines and you 
will see the Endpoint indicator.  Click to end the new line on the first 
line endpoint.

Hold the mouse pointer near the previous line and you will see the 
Midpoint indicator.  Click to end the new line on the previous line 
midpoint.



Page 45Introduction to OneCNC ©

Right click to end the chain of lines.

The Line command will still be active.  You can start a line at a new 
position and continue as before.

Click near a line you have already drawn.  The start point will be on 
the existing line.

The toolbox will display the distance the new 
start point is along the existing line.

Change the value in the Distance along entry 
box to move the start point to a new position 
along the base line.

If you prefer you can enter the position on the 
base line as a ratio of the base line length.

The Distance along and Ratio along values are 
interactive.
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Move the mouse pointer near another line and click to connect to it.

Right click twice to end the Line command.

Click on the Select All icon to select the lines you have just drawn.

Click the delete icon to clear the drawing area.

Start the Line command again and practice drawing lines.
You can enter an exact position for a line endpoint by entering 
coordinates in the toolbox.  You can also define a line by entering a 
value for line length, or angle from the last line segment.

Delete the lines when you are ready to continue.
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Rectangle

The Rectangle command creates a rectangle with the option of a given 
radius fillet on all the corners.

Click on the Rectangle icon in the Line menu to start the Rectangle 
command.

When the command is started, you have the 
option of entering a corner radius value.

Enter a Corner Radius of 5.

To define the first corner of the rectangle you can click on an entity or 
grid snap, or enter coordinates in the Toolbox.

This will be the point where the sides of the rectangle intersect before 
they are filleted.
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A preview of the rectangle is shown, with the second corner attached 
to the mouse pointer.  Click on or enter a position for the second 
corner.  The second corner can also be set by entering an X length 
and Y width for the rectangle. 

The mouse pointer is still active, ready to select a start corner for a 
new rectangle.

Draw some more rectangles, using different options such as a zero 
Corner Radius, or using values for Length or Width.

Right click when you are ready to end the command.

Click on the Select All icon to select the rectangles you have just 
drawn.

Click the Delete icon to clear the drawing area.
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Circles

The Circle command creates a Circle with a given diameter.

Click on the Arc icon to open the Arc menu in the toolbox.

The Circle icon in the Arc menu is highlighted, showing that the Circle 
command is started automatically.

Enter a Diameter for the circle in the Toolbox.  

A preview of the circle is attached to the mouse pointer.

Click on or enter a position for the center of the circle.
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The Circle command continues and you can place another circle by its 
center point.

You can change the Diameter in the Toolbox before placing the next 
circle.

Right click when you want to end the Circle command.

Click Select All and then click the Delete icon to clear the 
drawing area.
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Offset entities and boundaries

An offset entity or boundary is often needed when drawing a part.
In OneCNC this is done using the Parallel/Offset command.

To practice the Parallel/Offset command, draw a rectangle with filleted 
corners.

Offsetting single entities

Click on the Parallel/Offset icon in the Line menu to start the 
command.

When the command is started, enter the 
distance you want to offset in the Offset 
Amount entry field in the Toolbox.

Select a side of the rectangle.
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Move the mouse pointer around, and you will see a preview of the 
selected entity being offset.  When the preview is where you want the 
offset, click to create the offset entity.

You can now select another single entity, and create an offset by 
clicking when the preview is where you want the offset.

Right click to end the command when you have finished making 
single offsets.



Page 53Introduction to OneCNC ©

Offsetting a boundary

Delete the single offsets you made, or click on Undo till you return to 
the rectangle with filleted corners.

Click on the Parallel/Offset icon in the Line menu to start the 
command.

Enter the distance you want to offset in the 
Offset Amount entry field in the Toolbox.

Select  the same side of the rectangle.
The single offset preview will appear, but do not click to place it.
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Move the mouse pointer near the end of the selected line, and the 
connected boundary will be highlighted.  Click to select the boundary 
for offsetting.

Now the preview will show a preview of the entire boundary being 
offset.  Click to place the offset.  The command will recur.

Right click when you have finished creating offsets.

Select All and Delete before continuing.
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Moving Entities

Entities can be moved, copied, scaled, rotated and mirrored.
These Transform functions can be accessed by clicking on the 
Transform icon in the Toolbox to open the Transform menu.

We will start with the Move command.  Use grid snaps to draw a 
square evenly spaced around the world origin, and draw two circles 
on the corners at the left of the square.

Before starting a Transform command, entities must be selected.
Click on the Select icon to select entities one at a time.

Click on each of the circles to select them.  Selected entities change 
color to red when they are selected.  If you select an entity by 
mistake, click on it again and it will be removed from the selection 
set.

Right click to finish selecting.
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Click on the Transform icon to open the Transform menu in the 
toolbox.

The Move icon in the Transform menu is highlighted, showing that the 
Move command is started automatically.

You can select or enter a position as the start point for a move.  Click 
on the midpoint of the line between the circles.

A preview of the entities being moved will be attached to the mouse 
pointer.  Shadows indicate the original position of the entities.  Click 
on the midpoint of the opposite line to move the circles.

Right click to end the Move command.  The moved entities are 
still selected, ready for another command.



Page 57Introduction to OneCNC ©

Click Deselect All to leave the circles unselected.

Copy Entities

Click on the Select icon, and select the circle at the top of the square.

Right click to end the selection.

Click on the Copy Move icon in the Transform menu of the toolbox to 
start the Copy command.
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Select the intersection of the circle and the right side of the square as 
the start point of the move.

Move the mouse pointer to the left side of the square.  Click on the 
intersection of the left side of the square and the dashed horizontal 
indicator to set the finish point of the move.

Right click to end copying from the current start point.

The Copy move command is still active.  Select the center of the circle 
as the start point for another copy.
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Click on the diagonally opposite corner of the square to create a copy 
there.

Right click to end the current copy.

Right click again to end the Copy move command.

Click Deselect All to leave the original circle unselected.

Rotate

Entities can be rotated about a selected center of rotation.  The axis 
of rotation can be parallel to the X, Y, or Z axis of the World or Plane 
coordinate system.

Select all the sides of the square.

Right click to end the selection.
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Click on the Rotate icon in the Transform menu.

To select the center of rotation, move the mouse pointer to the 
intersection of the X axis and Y axis.  Click when the square World 
origin indicator appears.

To create the rotated square as a copy of the 
original, enter 1 for the #Copies value in the 
Toolbox.

The toolbox now shows six options for the axis of rotation.  The 
default rotation mode is Rotation Z plane, which rotates entities in the 
current drawing plane.

You can enter the exact degrees of rotation in any of these fields, but 
for common rotation amounts a rotation protractor with markers at 
15° intervals is shown in the drawing window.
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Move the mouse pointer around the protractor, and click to rotate the 
square by 45°.
 

Right click twice to end the rotation command.

Click Deselect All to leave the original square unselected.

Setting Current Drawing Properties

OneCNC has a 2 color drawing system, controlled by color selection 
boxes in the Status Bar.

The color selector on the left is for geometry and that on the right is 
for surfaces and models.  To set the current color, click the selector 
and select the color you want to use.  To switch back to the default 
color just click the small square in the corner of the selector.

To select the line style and line thickness you would like all new 
entities to be drawn with, click the Styles icon.

OneCNC uses red to indicate an object is selected, so don’t use red 
for drawing. 
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Using Layers

Every entity created in OneCNC is said to be ‘on’ a Layer.  Layers give 
you control over entities on each layer as a group.  For example, if 
you draw dimensions on a layer named ‘Dimensions’, you can then 
turn off display of the layer to hide all dimensions while working on 
the drawing geometry.

Click on the Layer tab at the lower right of the screen to open the 
Layer Manager.

Up till now you have been working in a new file, on the default layer, 
Layer 1.  We will now create a new layer and move some of the 
geometry to the new layer.

To add a new layer, click on the + icon at the top of the Layer 
Manager.

The new layer is created with the default name Layer 2.  Click on the 
icon next to the + icon to rename the layer.
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Enter ‘Circles’ as the name for the new layer, and click OK.

The Layer list is sorted alphabetically, so the Circles layer is now 
above Layer 1.  It is highlighted in blue, indicating it is the active 
layer new entities will be created on, but the X in the visibility column 
shows it is an empty layer.

Select all the circles in your practice drawing.

Click on the Modify icon in the Status Bar.

Default Layers
You can set default layers  to be contained in each new drawing 
from the File menu > Properties dialog.  Select the Layers tab, click 
New, give the layer a name, and set a default color, line type, and 
width.
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In the Modify Selected Attributes dialog, you can change the color, 
line type, thickness, or layer of entities.  Select the Circles layer in the 
Layer list to move the selected entities to that layer.

There is now a green eye icon in the Circles layer visibility column, 
indicating all entities on the layer are visible.  The red selection 
square indicates all entities on the layer are selected.  Click on the 
square to deselect the circles.

Click on the open eye icon for the Circles layer and it will close.
This will turn off display of all entities on the layer.
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Now you will be able to see the squares clearly.

Trimming Entities

Trim functions are used to shorten or extend existing entities.

Scissors
The quickest way to trim away unwanted parts of geometry is to use 
the Scissors tool.

Click on the Trim/Break icon in the Toolbox to open the Trim/Break 
menu.

Click on the Scissors icon to start the Scissors command.

Click on an unwanted part of a line or arc.
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The geometry will be trimmed back to the next intersection with 
another line or arc, and the command continues.  You can continue 
trimming by clicking on unwanted parts of geometry.  

Right click to end the command when you have finished trimming 
entities.

The Scissors command cuts entities back to the next intersection or 
endpoint in each direction from the point where you clicked on the 
entity.  If you click on an entity which is not crossed by another line 
or arc, it will be deleted.
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Trim Two

This function will shorten or extend two arcs or lines to their common 
intersection.  It is an important function as it can be used to make 
sure a chain of entities are properly connected at their endpoints.

Open a new file to practice using the Trim Two command.  Draw some 
lines that cross, and some unconnected lines.

Start the Trim Two command by clicking the Trim Two icon in the Trim 
menu of the Toolbox.

Click on the first line you want to trim, on the side of the intersection 
that you want to keep.
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Click on the second line you want to trim, on the side of the intersection 
that you want to keep.

The lines will be trimmed to their intersection.  In this example both 
lines were shortened.

The command continues, and you can click on the next line you want to 

trim.
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Click on the next line to trim.  In this example one line will be 
shortened and one will be extended to meet at their intersection.

Right click to end the command when you have finished 
trimming.  The four lines in this example have now been trimmed 
to form a closed boundary.

 

Click Select All and then click the Delete icon to clear the 
drawing area.

Some CAM operations require selection of consecutive entities as a 
profile chain.

Trim Two ensures that the junction between two entities is properly 
trimmed for chain selection, and can be used to repair a chain that 
will not select properly.
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Chain Selection

Chain selection is an important function that selects consecutive 
entities to form a profile chain.  A profile chain can be open or closed.
For many CAM functions you will need to select a profile chain of 
consecutive entities as the first step of the toolpath definition.
  

To practice chain selection, draw a filleted rectangle.

Selecting a complete profile as a chain

Click on the Chain Selection icon to enter chain selection mode.

The mouse pointer changes to the word ‘start’.
Click on the entity that will be the first in the chain.
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Move the mouse pointer around till the red arrows are pointing in the  
direction that you want to chain select.  Click to set the direction.

The mouse pointer changes to the word ‘end’.  Click on the last entity 
of the chain you want to select, or press the F3 key to select all 
consecutive entities automatically.

The chain will be selected.  You can now start to select another chain, 
or right click to end chain selection.
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Selecting part of a profile as a chain

Click on the Deselect All icon to clear the previous selection.

Click on the Chain Selection icon to enter chain selection mode.

The mouse pointer changes to the word ‘start’.
Click on the entity that will be the first in the chain.

Move the mouse pointer around till the red arrows are pointing in the  
direction that you want to chain select.  Click to set the direction.
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The mouse pointer changes to the word ‘end’.  Click on an entity to 
end the chain.

The mouse pointer is still seeking a chain end.  You can click further 
along the chain to add one or more entities to the chain selection.

Right click when you are ready to finish selecting the chain.  You can 
now start to select another chain, or right click again to end chain 
selection.
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OneCNC CAD Tutorial 2
2D Drawing

This Tutorial is designed for all OneCNC products.

In this tutorial we will be using some of the time saving features of 
OneCNC CAD drawing to show how easily a part can be constructed.  
We will be drawing a part with fillets and chamfers, and a slot at an 
angle of 75 degrees.

Start a new file, and save it as ‘Cad Tutorial 2’.

Click on the View icon in the Status Bar to open the View menu, 
and select CAD View.

CAD view is a special top down view, specifically for 2D drawing in the 

XY plane.
While in CAD view all drawing is in World coordinates.
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Step 1: Draw outer profile

Click on the Rectangle icon in the Line menu to start the Rectangle 
command.
Enter 0 for Corner Radius, to draw the rectangle with sharp corners.  

Enter coordinates in the toolbox or use a grid snap to start the 
rectangle at X10 Y10.  You can then enter 150 for Length and 100 for 
Height to make the rectangle 150 wide in X and 100 high in Y.

To create the semi-circle on the right side of the part, start the Arc 

Sketch command on the Arc menu.

Click on the midpoint of the vertical line at the right side of the part to  

locate the center of the arc.
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The Arc Sketch function now requires the arc Radius, Start Angle, and  
End Angle.  Each of these can be defined by entering a value in the 
toolbox, or clicking on an entity or grid snap.

Enter 15 in the toolbox for the Radius of the 
arc.

Click on the endpoint above 
the arc center to set the 
Start Angle to 90°.

Click on the endpoint below 
the arc center to set the End 
Angle to 270°.



Page 77Introduction to OneCNC ©

Right click to end the Arc Sketch command.

To draw the angled line at the top left of the part, select the Line 
menu to start the Line command.

Click on the vertical line at the left of the part, between the midpoint 
and upper end.

To fix the start point of the line at 40mm from 
the end of the selected line, enter 40 as the 
Distance along value in the toolbox.
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Enter -60 for the Line Angle.

This will fix the angle of the new line at 60° 
from the direction of the anchor line.

Move the mouse pointer along the new line preview until it locks onto 
the horizontal line at the top of the part, and click to draw the line.

Right click to end the Line command.

We can now trim away the unwanted line segments.
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Start the Scissors command on the Trim/Break menu.

Click on the segment within the semicircle to remove it.

Click on the segments at the top left of the part to remove them.

Right click to end the Scissors command.

Next we will create the fillet on the lower left corner of the part.

Start the Fillet command on the Arc menu.
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Enter a Fillet Radius of 25 in the toolbox.

Click on the left side of the 
part near the lower left 
corner.

Click on the lower side of 
the part near the lower left 
corner.

The fillet is created, and 
the corner is trimmed 
automatically.

Right click to end the Fillet 
command.
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Next we will create the chamfer on the lower right corner of the part.

Start the Chamfer command on the Line menu.

Enter a Chamfer Distance of 15 in the toolbox.

Click on the lower side of 
the part near the lower right 
corner.

Click on the right side of the 
part near the lower right 
corner.

The chamfer is created, 
and the corner is trimmed 
automatically.

Right click to end the 
Chamfer command.
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Step 2: Draw the angled slot

The first step in construction of the slot will be to draw the centerline.

Select the Line menu to start the Line command.

Move the mouse pointer near the center of the fillet arc, and click to 
place the start point of the line there.

Type 25 in the Line Length box, and press 
Enter.

Type 45 in the Line Angle box and press Enter 
again.

The line will be drawn.

Right click to end the current Line sequence, and right click again to 
end the Line command.
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The part drawing should now look like this.

Start the Circle command to draw circles which will become the arcs 
at each end of the slot.

Type 10 in the Diameter entry box.

Click on the lower endpoint of the centerline to draw the first end arc 
of the slot.
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Type 20 in the Diameter entry box.

Click on the upper endpoint of the centerline to draw the second end 
arc of the slot.

Right click to end the Arc command.  You should now have two 
circles of unequal diameter, one at each end of the centerline. 
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Next we will join the circles with tangent lines.

Start the Line Tangent command in the Line menu of the Toolbox.

Draw the first tangent line by clicking near where the tangents will be.

Draw the second tangent line by clicking near where the tangents will 
be.

Right click to end the Line Tangent command 
and you will have two tangential lines as 
shown here.
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Begin the Single Selection command.

Select the 45 degree centerline.

Right click to end the selection process.

Click the Delete icon or press the Delete key to delete the 
centerline.

All we have to do now is trim the circles to 
the tangent lines to finish the slot.

Start the Scissors command on the Trim menu.
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Click on the unwanted segment of the lower circle to trim it away.
Circles have an endpoint at 0° so you must click twice to remove both 
ends of it.

Click on the unwanted segment of the upper circle to trim it away.
The remaining arc will be composed of two arcs because of the circle 
endpoint at 0°.  It is good practice to trim this to one arc.  Click below 
the 0° endpoint to remove the smaller arc.

Because the smaller arc is not crossed by 
any other entity, the Scissors command 
removes it completely. 

Right click to end the Scissors command.
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Start the Trim Two command.

Click on the tangent line to select it as 
the first entity to trim.  Click between the 
endpoint and the midpoint of the line.

Click on the arc to select it as the second 
entity to trim.

The two entities will now be joined perfectly.

Your drawing should now look like the picture at the beginning of this 
tutorial, which is now complete.  
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This tutorial is intended for Expert and Professional versions of OneCNC.

In this tutorial we will use OneCNC solid extrude commands to 
construct a 3D solid part.  You will need the outlines drawn in CAD 
Tutorial 2 before attempting this tutorial.  We will extrude the part 
with a taper angle and cut the through slot with vertical walls.

Step 1: Complete CAD Tutorial 2 and save a copy.

Complete ‘CAD Tutorial 2’ and save the file.  Use Save As on the File 
menu to save a copy as ‘CAD Tutorial 3’.  Press the Space bar and 
set the view to Trimetric.  Your part should appear as shown in this 
image.

OneCNC CAD Tutorial 3
Solid Modeling by Extrusion
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Step 2: Create a solid by extrusion from curves.

Click on the Extrude icon in the Toolbox to open the Extrude menu.

Click on the Extrude Curves icon.

Enter a Taper Angle of 15 in the parameters 
section of the Toolbox.  This will tilt the walls of 
the extrusion inwards.

Leave the Linear Corners check box 
unselected.

OneCNC now seeks a 
boundary to create an 
extrusion from.  Hover the 
mouse anywhere near the 
external boundary and click 
to select it as the outline of 
the part.  The entire outer 
boundary will be selected 
with one click.

You can extrude a shape 
with one or more openings, 
so the cursor will continue 
to seek boundaries.

Do not select the inner 
boundary.

Right click to end the selection stage of the command because in 
this case we want to create the slot using different settings.
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The height of the extrusion can be set by a mouse click or by entering  
the height in the toolbox. As you move the mouse, you will see a 
preview of the extrusion, and the current height will be displayed in 
the toolbox height entry.

Enter a Height of 10 in the parameters section 
of the Toolbox, and press the Enter key.

Click in the drawing window and the extruded solid is created with an 
external taper of 15 degrees.

Right click to end the command.
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Step 3: Create the slot with an extrude cut

The slot boundary we want to use is obscured by the solid we have 
made.  We could change the view direction but there is no need to do 
this, as we can change the model display setting to Transparent.  

Click on the Display icon to open the Display menu.

Select Transparent.  The slot geometry will now be visible 
through the part.

Click on the Extrude cut icon in the Extrude menu.

Change the Taper Angle to 0 so the slot will 
have vertical walls. 

Select the internal boundary to create the cut extrusion.
Only one boundary can be used for an Extrude cut so you do not have 
to right click to end the boundary selection.
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Because we want a through cut the exact extrusion distance is not 
important.  Move the mouse pointer up until the extrusion preview is 
above the part, and click to make the extrude cut. 

Right click to end the Extrude Cut command.

Click on the Display icon and change the display mode back to 
Normal.

To see how you can create a section view of your model, open the 
Section Tool topic in OneCNC Help.
You can find the topic in Help Contents -> CAD Drawing and 
Modeling -> Modeling Tools -> Section Tool.
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All new line and arc geometry, and surface and solid models, are 
created in the current construction coordinate system, which is 
independent of the world coordinate system.

When you open a new file in OneCNC, the current construction plane 
is the XY plane.  The X and Y axes of this plane coincide with the X 
and Y axes of the world coordinate system.

A transparent rectangle indicates the position and orientation of the 
XY plane of the current construction coordinate system.  The Origin 
selector at the right of the Status bar shows World coordinate input is 
active.

Clicking on the Origin selector will activate Plane coordinate input.
A plane origin indicator will appear.

OneCNC CAD Tutorial 4
Working With Planes
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As an introduction to Plane functions we will position a Plane as an aid 
to constructing a truncated wireframe pyramid.

Step 1: Draw a pyramid wireframe

Start a new file, and save it as ‘Cad Tutorial 4’.

Select World coordinate input, and use the Rectangle command to 
draw a square from X0 Y0 to X100 Y100.

Start the Line command, and click on the corner of the square to start 
the first edge of the pyramid.
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Enter World coordinates as shown to end 
the edge at the vertex of the pyramid.

Click on an adjacent corner of the square to finish the second edge of 
the pyramid.

Right click to end the current Line sequence, and construct the other 
two edges by clicking on corner, vertex, and corner.
Right click twice to end the Line command.
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Step 2: Position the plane

Open the Planes dialog by clicking on the Plane icon in the Status 
Bar.

In the Planes dialog you will see the XY 
Default Plane is selected in the Saved 
Planes list.

You will also see the pre-defined YZ and 
XZ planes.

The Display active plane check box must 
be selected for the plane to be visible.

Click on the Push or Pull Plane icon in the Planes dialog.

This command will move the current plane up or down along its Z 
axis.

Enter a drag amount of 50, and click OK.

The plane will be moved vertically by 50mm.
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Click on the Origin selector to activate plane coordinates.
The Plane origin indicator shows the origin of the moved 
plane.

We will now tilt the plane on its own Y axis to create the angle for 
truncation of the pyramid

Click on the Plane icon again to open the Planes dialog.

Click on the Rotate Plane icon.

The plane can be rotated around the World axes or its own axes.

To rotate the plane around its own Y axis, enter 15 in the Plane Y tilt 
entry box and click OK.
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The plane is tilted on its own Y axis.  The plane origin will still be 
directly above the World origin.

We will save this plane position so we can return to it easily.

Step 3: Save the plane position

Click on the Plane icon again to open the Planes dialog.

Click on the Save icon.

Name the plane Truncation plane and click OK.
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The plane now appears in the Saved 
Planes list.

Step 4: Create the truncated pyramid

To truncate the pyramid edges, open the Trim menu in the Toolbox, 
and click on the Trim to plane icon.  This command trims lines or arcs 
which pass through the plane to the plane intersection.

Click on an edge of the pyramid, between the base and the plane.

The edge will be cut off where it meets the plane.  Click on the next 
edge to trim it.
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The edge will be cut off where it meets the plane.  Click on the next 
edge to trim it.

Continue until all four lines are trimmed to the plane.

When you have trimmed all four side edges of the pyramid, use the 

Line command to join them.  These lines form the boundary of the 
truncation.
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Step 5: Return to default XY plane

To return to the XY plane, open the 
Planes dialog and select the XY plane in 
the Saved Planes List.

To return to World coordinate input, 
clear the Use plane coordinate system 
check box before clicking OK.

You will see the XY plane is 
current again.

You can return to the 
truncation plane by 
selecting it in the Saved 
Planes list.

To learn more about plane commands in OneCNC, go to ‘Construction 
Planes’ in the CAD section of OneCNC Help.
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This tutorial is intended for Expert versions of OneCNC, and Solid Creator.

Automated 3D model to 2D CAD drawing is a standard feature of 
OneCNC Solid Creator and OneCNC Expert versions, and can be added 
as an optional module to OneCNC Mill Professional.

Traditionally, a technical drawing was the first step in production of a 
part.  Now, you can design the part as a 3D model, and create one or 
more technical drawings automatically from the part.

The paperspace drawings are associated to the model, so if the design 
changes, you can change the part model and then update the drawing 
views automatically to show the revised part.

There are two stages to creating a technical drawing in OneCNC.
The first step is to create a drawing page layout with title block and 
border.  You can then create and manage views of your model in the 
layout.

OneCNC Technical Drawing
Automated 3D to 2D Drawing Layouts
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Add a drawing page with border and title block

To add a new page, click on the Pages icon in the Status Bar.

The Page Manager dialog will open.

Click on the Add page 
icon to open the Page 
Setup dialog.
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Templates are supplied for standard paper sizes with pre-drawn 
borders and title blocks. Select a template for the paper size you want 
from the Templates list, and enter a name for the page.

The Auto fill template section contains entries which can be 
automatically added to your title block. Fill these out as necessary, 
and click OK.

The new page now appears in the Pages list in the Page Manager.

The selected page will be seen in the main drawing window, with the 
title block showing the details input in the Page Setup dialog.  You can 
now place views from the Views list into the new page.

To return to the main drawing environment, select Model Space in the 
Pages dialog.
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Add views of the model to a drawing page layout

You can add a view of the model to an existing drawing page layout at 
any stage of the design process.

In the Pages list of the Page Manager, select the page layout you want 
to add the view to.

Select the view in the Views list, and a preview of the view will appear 
in the lower section of the Page Manager dialog.

Click the Place view on page icon to add the view to the page.
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The view will be attached to the cursor.  Click to place the view when 
it is in the position you want.

After placing the view, you are returned to the Pages Manager again, 
and you can continue placing views as necessary.

Views are not restricted to orthogonal representations. An Isometric 
view gives a good indication of what the part actually looks like.
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You can create a section view in the Views list using a plane 
positioned where you want the section.

You can also use a plane to define a view from a specific direction.

Views and section views can be dimensioned as necessary to 
complete the drawing.

Using the 3D to 2D Technical Drawing module you can quickly create 
professional drawings to recognized standards.  For more detail on 
using the module see the Automated 3D to 2D drawing topic in the 
CAD section of OneCNC Help.
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This tutorial is intended for all levels of OneCNC Lathe.

In this tutorial we will open a sample file with turning already defined, 
and copy the example turning in a new toolpath group.

Open the sample file and save a copy.

Sample files are supplied with OneCNC which provide examples of 
parts and toolpaths.  Click on the Open icon and go to the Samples 
folder, which is located in the Drawings folder where you installed 
OneCNC.

OneCNC Lathe Tutorial 1
View A Sample Part

The World and Lathe Coordinate systems

OneCNC Lathe can be used with the World XYZ Coordinate system, 
or set so that the World X and Y axes becomes the lathe Z and X 
axes.  In the lower corners of the screen you will see the World axis 
origin indicator on the left, and a red ZX reminder indicator on the 
right.

To change the Coordinate system, open the OneCNC Properties 
dialog from the File menu.  On the General tab you will see the 
coordinate options in the Interface section.
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Select the file ‘Conet metric.ONECNC’ and click Open.

Select Save As from the File menu, and save a copy of the file as 
Tutorial Lathe 1.

Press the Spacebar and select CAD View from the View menu. 

This solid model has been created in Lathe Professional from the 2D 
profile drawing.  Lathe Express can open solid models but does not 
have the tools to create them.

All levels of OneCNC Lathe can display a visualisation of the turned 
profile called a lathe model.  The lathe model is created by selecting 
a profile chain which is then revolved about the lathe axis.  It is a 3D 
entity and can be viewed from any direction but is a visualisation only 
and is not selectable in the way a solid model is.
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Display a lathe model

Click on the Select Single icon.

Click on the solid model to select it.

Click on Blank in the Modify toolbar.

The solid model will be hidden and you will see the profile used to 
create it.  You will also see two rectangles which are boundaries used 
to define the back turning operations.

Click on the Model Tools icon and select Create Lathe Model.
You will be prompted to select a profile chain.

Click on the arc on the right to select it as the start of the profile.
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Click while holding the 
mouse above the profile to 
set the direction the chain 
will be selected in.

Select the horizontal line 
at the left of the profile 
for the end of the profile 
chain.  Right click to end the 
selection.
 

The lathe model is created 
by revolving the selected 
profile about the lathe 
axis, and can be viewed 
from any direction.  It is a 
visualisation only and will be 
the default geometry color 
as it is not a solid model.

When you are ready to continue, click on the Clear Model icon in the 

Model Tools menu to remove the visualisation from the screen.
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Simulate the existing toolpath group

The sample file has a toolpath group 
called CONET with turning operations 
already defined.  Right click on 
the group name CONET in the NC 
manager, and select Simulate / Rest.

The NC Solid Verification dialog appears.

Select the Round bar stock type.  Clear the automatic offset check 
box, and enter a Stock Diameter of 100.  Enter -144 for Start Z and 3 
for End Z, and click OK.
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The Live Simulation window opens with the same view as the drawing 
window, and simulates the existing toolpath group operations.

The current coordinates of the  tool are displayed in the top right 
corner.

Use the video controls to play, pause or rewind the operation.

Observe the simulation, and take note of the OD, Face and Back Turn 
operations for roughing and finishing, which we will recreate in a new 
toolpath group. 

You will notice the tool color changes to red while in a rapid move.
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The Live Simulation window has simple playback controls.

Go back to start of simulation.

Go back to the start of the previous tool.

Pause. This changes to Play when paused, which will resume the 
playback.

Enter simulation Step Mode.

Skip forward to the start of the next tool.

Go to end of simulation.

Turbo mode enables rapid simulation at lower resolution. 

You can adjust the playback speed of the simulation by dragging the 
indicator in the sliding speed control.

You can select a specific playback speed using the drop-down selector 
below the sliding speed control.
For example, if you select x2 the playback will be twice as fast. If you 
select /2 the playback will be at half the speed.

During simulation, the progress indicator in the progress bar 
moves from left to right.  The background color of the progress bar 
changes to match the current tool.  You can change the playback 
position by dragging the progress indicator in the progress bar.
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The toolbox on the left of the simulation window has view and display 
controls.  It also holds useful functions for checking your toolpaths.

The view tools allow you to change your 
viewpoint and zoom magnification. 

The Rest material functions are used to 
check for material which has not been 
removed yet.

The Display options can be used to show 
or hide the tool or geometry.

If you are simulating a multi-axis 
toolpath you can also change the axis 
simulation mode.

The Options icon re-opens the stock 
settings dialog.

When the simulation ends the simulation window remains open.  
Close the simulation window when you are ready to return to 
OneCNC.
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This tutorial is intended for all levels of OneCNC Lathe.

In this tutorial we will create a new group of toolpaths for the sample 
part viewed in the previous tutorial.

Step 1: OD Turn Rough toolpath

Right click in the NC manager 
toolpath list area, and select New 
Group.

A new group is created with the 
default name ‘Toolpath Group #2’

Click on the Process icon in the NC Manager tab to open the 
Process operation dialog.

Change the group name in the 
Description box to CONET Practice, 
and click OK.

Press the Spacebar twice to select the CAD View.

OneCNC Lathe Tutorial 2
Turning A Sample Part
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Click on the existing 1:ODTurn Rough operation in the first group, 
and you will see an instant preview for that toolpath in the drawing 
window.  The new group remains the active group new toolpaths will 
be created in.

For clearer images, we have turned off display of the active plane, but 
it is not necessary to do so to follow this tutorial.

To re-create the OD Turn Rough lathe operation in the practice group, 
click on the Lathe toolpaths icon and select Turn / face roughing.

It is now time to select the chain of entities we want the toolpath to 
follow, and specify the offset side and direction of travel.

The cursor will change to the word ‘start’, and the selection box will 
attach itself to the nearest entity.  Hover the cursor near the arc at 
the right side of the part, and click to select this as the start of the 
chain.
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Four direction and side indicator arrows appear.  

Hold the mouse so that the red arrow is above the arc, and pointing 
to the left, and click to confirm this side and direction.

The cursor will change to the word ‘end’.  Click on the horizontal line 
at the left of the part to select it for the end of the profile chain.  

Right click to end the selection process.
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The first stage of the toolpath wizard is the Select Tool dialog.  Click 
on the Tool Changer icon to open the Tool Library.
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The Tool Changer dialog opens, with the Recent tab active.  
Tools you use regularly can be selected quickly from this tab.

To select a tool which is not shown in the Favourites list, click on the 
Library tab to see a categorized display listing all available tools.
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The Tool Library is composed of separate lists for each category of 
tool.  Each row in a list stores information for a single tool.

When the Turn / Face tool icon at the left of the dialog is selected, the 
displayed list will show available tools for OD turning.
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Select the CNMG 12 04 08 OD Rough Right tool by clicking anywhere 
in the row for its listing, and click OK to return to the Select Tool 
dialog.
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The tool image will update with a preview of the selected tool.

Enter 1 for the Station number, and the Tool Offset will be entered 
automatically. 

Select Coolant No. 1 and Work Offset G54.

Enter a Feedrate of 0.8 to match the tip radius of the tool, and select 
the mm/rev option.

Enter a Surface Speed of 60 and select the CSS Constant Surface 
Speed option.

Select the Max spindle speed check box and enter a value of 2500.

Click Next to proceed.

Note: 
 
If the tool has a Station number in the Tool Library, the Station 
number and Tool Offset will be set when the tool is selected.
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The next dialog gives you options for clearance moves, which are only 
necessary if avoidance is required.

Select No Move and click Next.
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In the Boundary of Toolpath dialog pick the Select Contour option, set 
Z and X clearance to 5, and click Next.

The importance of setting correct Clearance values
The clearance values in Z and X define where the stock surface is 
in relation to the part.  This is where cutting starts, and must be 
set accurately or the tool could contact metal while still in a rapid 
positioning move.  Compare the toolpath result for a small part with 
a radius of 25.

      Z and X clearance 5                        Z and X clearance 10
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In the Turning Options dialog, select Longitudinal and Auto for cut 
direction, and Normal roughing style.

Set Finish allowances to 0.5 in X and Z.

Set the Cut amount for the cut depth of each pass to 2, the Retract 
Clearance between cuts will update to match this setting.  Select 
Overlap to create a small move at the end of each pass that will clean 
up material that would otherwise be left behind.

 Set Cut Grooves to on and click Next to continue.
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Select the check boxes for Cut from start and Cut to end.

These settings move the tool control point past the geometry by the 
tip radius, ensuring all of the geometry is cut.  You can also add extra 
distance to the entry or overcut.

Click Finished to create the toolpath.

Double click on the new toolpath and 
rename it 1:ODTurn Rough in the NC 
Processing dialog.
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Step 2: Facing toolpath

The next step is facing.  This can be done using a Turn/Face Rough 
toolpath, but we will use the Facing toolpath.

Click on the Face icon in the Lathe Toolpaths menu.

Select the vertical line at 
the right of the profile for 
the facing operation.
The Select Tool dialog opens 
immediately.

Click on the Tool Changer and select the tool used for the previous 
operation from the Recent tab.  Enter the same feed and speed 
settings.
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The next dialog gives you options for clearance moves, which are only 
necessary if avoidance is required.

Select No Move and click Next.

For details of the Clearance settings and how they affect the start 
and end of a toolpath, see the Clearance Settings topic in the Lathe 
Toolpath Settings section of OneCNC Help.
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The Facing Options dialog will appear.

Enter 5 for X Clearance and Entry amount to start the facing before 
the tool reaches the geometry.  Select Roughing stepover and enter 
a value of 1.5.  Enter 4 for Amount to remove.  Select Leave amount 
and enter 0.5.  Leave Finish pass unchecked as we are only roughing 
at this stage.  Enter 0.8 for Overcut amount and 1 for Retract amount.
Click Finished to create toolpath.

The new toolpath is generated, and will be previewed in the drawing 
window when it is selected in the NC Manager.
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Step 3: Back Turn Rough toolpath

You will have noticed that the tool used for the OD Turn roughing 
is unable to reach the lower portion of the profile, so a back turn 
operation is required.

Select Turn / Face roughing again.

We will use the larger of the pre-drawn boundaries to limit the range 
of the toolpath.  Click on the line to the left of the boundary to start 
the chain selection.

Click above and to the right of the start position to set the side and 
direction for the toolpath.
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Click on the line to the right of the boundary to end the chain.

Right click to end the selection process.

Click on the Tool Changer icon to open the Tool Library, and select the 	
VNMG 160408 insert in a left hand J type holder.  Change the feed 
setting to 0.8 mm/rev, and click Next.



Page 134 Introduction to OneCNC ©

Select No Move in the Clearances dialog and click Next.
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In the Boundary of Toolpath dialog, choose the Select Boundary 
option and click Next.

For details of the Boundary settings and how they affect a toolpath, 
see the Boundary Settings topic in the Lathe Toolpath Settings 
section of OneCNC Help.
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In the Turning Options dialog, select Longitudinal for Cut Direction, 
and click Next.
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Select the check boxes for Cut from start and Cut to end.
Click Finished to create the 
toolpath.

The message pane in the 
Status bar prompts for a 
boundary.  Click anywhere 
on the larger rectangle.

The instant preview is 
displayed, and you can see 
that the toolpath is limited 
to that part of the selected 
profile within the boundary 
rectangle.

Double click on the new 
toolpath and rename it 

3:Back Turn Rough.
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Step 4: Face Turn Finish toolpath

Click on the Lathe Toolpaths icon and select Turn / face finishing.

Click near the upper end of 
the line at the right of the 
part, and click to set the 
side and direction of the 
toolpath as shown.

Right click to end the 
selection of the single line.

Click on the Tool Changer icon to open the Tool Library, and select 
the 	VNMG 160408 insert in a right hand J type holder.  Enter the tool 
settings as shown, with a feed setting of 0.4 mm/rev, and click Next.
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Select No Move in the Clearances dialog and click Next.
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In the Boundary of Toolpath dialog, choose the Select Contour option.

Enter Z and X clearance of 5.

Minor X Clearance can be used to add clearance to the inner end of 
the toolpath, but we don’t need it for this operation so leave this set 
to 0.

Enter an approach clearance of 3 and click Next.
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In the Turning Options dialog, select Facing for Cut Direction.

Enter the other settings as shown, and click Next.

For details of the Turning Options settings and how they affect a 
toolpath, see the Turn and Face Cut Settings topic in the Lathe 
Toolpath Settings section of OneCNC Help.
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Select the check boxes for Cut from start and Cut to end.

Click Finished to create the toolpath.

Rename the new toolpath 4:Face Turn 
Finish.
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Step 5: OD Turn Finish toolpath

Click on the Lathe toolpaths icon and select Turn / face finishing.

The cursor will change to the word ‘start’, and the selection box will 
attach itself to the nearest entity.  Hover the cursor near the arc at 
the right side of the part, and click to select this as the start of the 
chain.

Hold the mouse so that the red arrow is above the arc, and pointing 
to the left, and click to confirm this side and direction.
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The cursor will change to the word ‘end’.  Click on the horizontal line 
at the left of the part to select it for the end of the profile chain.  

Right click to end the selection process.

Click on the Tool Changer icon to open the Tool Library, and select 
the 	VNMG 160408 insert in a right hand J type holder.  Enter a feed 
setting of 0.4 mm/rev, and click Next.
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Select No Move in the Clearances dialog and click Next.
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In the Boundary of Toolpath dialog, choose the Select Contour option 
and click Next.



Page 147Introduction to OneCNC ©

In the Turn and Face Options dialog, select Longitudinal for Cut 
Direction, and click Next.
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Select the check boxes for Cut from start and Cut to end.

Click Finished to create the toolpath.
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Rename the new toolpath 5:OD Turn 
Finish.

Looking at the preview of this toolpath, you will see the region the 35 
degree tool could not reach is bounded by the smaller rectangle.

We will finish this region with a back turn operation.
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Step 6: Back Turn Finish toolpath

Click on the Lathe toolpaths icon and select Turn /  face finishing.  

Click on the part outline to start the chain selection, outside and to 
the left of the small rectangle.

Hold the mouse pointer as shown and click to set the side and 
direction of the toolpath.
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Click the horizontal line outside and to the right of the small rectangle 
to end the chain.

Right click to end the selection process.

Click on the Tool Changer icon to open the Tool Library, and select the 
VNMG 160408 insert in a left hand J type holder.  Enter a feed setting 
of 0.4 mm/rev, and click Next.
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Select No Move in the Clearances dialog and click Next.
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In the Boundary of Toolpath dialog, choose the Select Boundary 
option and click Next.
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In the Turning Options dialog, select Longitudinal for Cut Direction, 
and click Next.
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Because the limits of this toolpath will be defined by a boundary, the 
Cut from start and Cut to end settings can be left unselected.

Click Finished to create the toolpath.
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The message pane in the Status bar prompts for a boundary.

Click anywhere on the smaller rectangle to select it.

Rename the new toolpath to 6:Back 
Turn Finish.  

You will now have the complete toolpaths for the part in your new 
group.
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Step 7: Posting NC Code.

Now that the toolpaths are complete we can output the NC program 
to send to the machine.

Most CNC machines use NC programs in which the common G and M 
codes follow the ISO standard, but each maker uses special codes in 
different ways so it is necessary for OneCNC to format the file as it is 
output.

The formatting definition is called a ‘Post’, which is short for post-
processor.  OneCNC is supplied with prepared Posts for most 
machines.

Select the heading of the CONET 
Practice group, and click on the 
Process icon at the top of the NC 
Manager.

Note: 

Customizing a Post is covered in detail in the Help files in ‘NC Post 
and DNC Settings’, found in the OneCNC Lathe section.



Page 158 Introduction to OneCNC ©

This opens the NC Processing dialog which has controls and tools for 
post-processing your program.

Click on the drop down menu to select the post-processor for your 
machine from the list.



Page 159Introduction to OneCNC ©

Enter any additional information in the text fields of the NC Processing 
dialog and click on the Post icon to output the NC program.
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The file Save As dialog appears.  Choose the folder to save the file to, 
and enter a name for the file.

Select the file type from the drop down menu on the Save As dialog.

Click Save to create the file.

Note:

If your machine requires a file extension that is not listed, type the 
filename with dot and file extension in the File Name field and set 
‘Save as type:’ to ‘Text or Ascii files’.  That extension will become 
the default extension, and will be added to the ‘Save as type:’ list.
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Your NC file opens in OneCNC Link,  which is an independent text 
editor and RS232 communications program.

When you first start using OneCNC you should check the output is 
formatted correctly for your machine.  Once your format is proven 
you can post files with confidence.

Click on the Send icon on the OneCNC Link Standard toolbar to open 
the communication dialog for your machine.  

 

Note: 

Comprehensive information on how to use the OneCNC Link NC 
Editor, and setup communications, is available in the OneCNC Link 
Help files.
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This tutorial is intended for all levels of OneCNC Lathe.

As you have worked through these tutorials, you will have noticed the 
Templates area on the left of the toolpath wizard dialogs.  Toolpath 
settings are saved automatically by OneCNC in the history section of 
the Templates panel so you can re-use them easily.  The settings are 
available in any part you are working on, so you can confidently apply 
tested settings to new parts.

Using saved toolpath template settings

Every time you create a toolpath, template settings are automatically 
saved with default names based on the tool used.  

To use a template, double click on the 
template name in the template panel, 
and the settings that were used for 
that toolpath will be reloaded in all the 
toolpath wizard dialogs.

You can then step through the toolpath wizard to check the settings, 
and click Finished to create the toolpath.

The settings can still be changed as you check them, which makes 
it easy to create a toolpath which is similar to but varies from the 
original.

OneCNC Lathe Tutorial 3
Using Toolpath Templates
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Saving a template as a favourite

While doing the finishing on our part, we created an OD Turn finishing 
operation.

This is an example of the type of toolpath which is a good candidate 
for saving as a favourite.

To access the settings, right click on 
the finishing operation, and select 
Edit Operation from the context 
menu.



Page 164 Introduction to OneCNC ©

Before saving a history template as a favourite, step through the 
toolpath wizard, checking the tool and settings as you go, until you 
reach the last dialog of the wizard.

Right click in the area at the left of the screen, and select Save 
settings from the context menu.
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The Save Template dialog opens.  Type a name for your operation in 
the Name: box.

This operation has been named 
‘T3 OD FINISH 35 RIGHT ALU’

It is best to establish a naming system that records the most 
important identifying details of the template.  This is very important in 
a team environment, but even if you are the only user of the system 
a good naming convention will help you find the template when you 
need it.

Once saved, the template appears in the 
favourites list of the Templates panel.
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To guard against accidental editing, lock 
the template by clicking on the padlock 
icon next to the star.

Click Yes to save the settings as they are before locking.

The template is now locked, and can be 
re-used with confidence.

It is important to understand that a template is simply a method of 
pre-filling the wizard settings, which can still be changed after the 
template has been selected.
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Creating templates from templates 

One time-saving way to build your template set is to use an existing 
template as a basis for a new one.

In this example we have saved a template using the ‘OD Finish Right 
35 deg .4 tip’ tool.  We can easily create a template for the equivalent 
left tool.

Start a new Turn Face Finishing operation, and load the T3 OD FINISH 
35 RIGHT ALU template.
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Click on the Tool Changer icon to open the Tool Library, and select the 
VNMG 160408 insert in a left hand J type holder.

Right click in the Templates panel, and 
select Save settings.
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Save the current settings as 
‘T4 OD FINISH 35 LEFT ALU’.

You now have two templates with the 
same settings except for the tool being 
used.

The original template will be unaffected.
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The Lathe Tool Library

This tutorial is intended for all levels of OneCNC Lathe.

This tutorial will explain how to use and manage the Lathe Tool 
Library, which is a built-in database in which you can store definitions 
for all the tools you use.

OneCNC Lathe Tutorial 4
The Lathe Tool Library
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You will usually access the lathe Tool Library from the Select Tool 
dialog in a toolpath wizard, by clicking on the tool image or the Tool 
Changer icon.

When you are not in a toolpath wizard, it is 
also accessible by clicking on Edit Tool List in 
the NC menu.



Page 172 Introduction to OneCNC ©

There are two tabs in the Tool Library dialog.

The Recent tab tool list makes it easy to select tools that you use 
often.

The list shows tools that are already in use in the current file.

The list also shows tools tagged as favourites in the Tool Library and 
tools that have been used in recent files.

Any of these tools can be selected for the current toolpath.  A preview 
of the selected tool is shown beside the list.
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The Library tab contains your complete tool library, with a separate 
list for each tool category.

The tool categories are shown at the left of the tab.
To select a category, click on the tool type icon and the list for that 
category will be shown.

Each row in the list stores information for a single tool.  You can select 
a tool by clicking anywhere in the row.  At the top of the Tool Library 
tab you will see a  preview of the selected tool.

Note: 

The tool library lists mill tools as well as lathe tools.
You can only select lathe tools for lathe toolpaths.
If you have an optional Mill-Turn module you will be able to select 
mill tools are for use with Mill-Turn toolpaths.
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Adding a tool defined as an insert only

A tool can be defined as an insert only, or an insert and holder 
combination.  An insert definition is all that is needed for the 
calculation of toolpaths.  

In this section we will go through the process of adding a tool defined 
as an insert only, and explain the various settings as we go.

The Library normally opens as a read only list to prevent accidental 
modification.

Select the Enable Edit Tools check box.

The Search, New, Clone, and Delete buttons will appear, and the 
background color of the list will change to remind you the list is in edit 
mode.
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Click on the New button.
A new tool definition row will be added to the Tool Library.

Click on YES in the Favourite column to remove it from the Favourites 
list.

Description:
The default description in this category is TURN/FACE (1).  Click on 
the description to select the cell and click again to open it for editing.  
Name the new tool CNMG 09 03 04 - OD Finish Right 80 deg 0.4 tip

Reference position:

This is the zero/reference point of the tool 
used for calibrating the tool on the machine.  
Click in the entry box and the selection dialog 
will open.  Click on Nose Tangent to select it.



Page 176 Introduction to OneCNC ©

Tool#:
Enter 1 for the station number the tool will be held in on the machine.

Library#:
This is a catalog number for identifying the tool, which should be 
unique in your system, as the Search function will return the first 
instance of the tool number it finds.  The new tool is assigned the first 
available number automatically.

Click in the Corner Radius entry box and the Lathe Tip Settings dialog 
will open.  Enter the tip settings as shown.

Shape:
The insert shape is defined by the first letter of the insert code.  
Select C = 80° diamond.

Corner radius:
The corner radius is defined by the last number of the insert code.  
Select 04 = 0.40mm

IC Diameter:
The first number of the insert code denotes the inscribed circle 
diameter that defines the size of the insert.  Enter 9.525.

Thickness:
The insert thickness is defined by the second number of the insert 
code.  Select 03 = 3.17mm

Click OK to return to the tool list.
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Note: 

For a left hand tool, add 90 to the angle between the tip and 
perpendicular, and then add the tip angle.  If we were adding a left 
hand tool the Lead Angle would be 90+5+80=175.

Lead angle:
If you select a holder, you do not need to enter the lead angle, it will 
be set automatically by the holder style.

If you do not select a holder, this is the angle between the leading 
edge of the insert and the positive direction of the lathe Z axis.

To find the angle for a right hand tool, subtract the angle between the 
tip and perpendicular from 90.  For an 80° tip it is 90-5=85, so enter 
85 for the Lead Angle.
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Relief angle:

This is a clearance angle from the side of the tool opposite the leading 
edge, which is used by OneCNC to determine the approach angle to 
the part.  Set this to the default value of 1.

Color:
Click in the color box to pick a color to associate with the tool. 

The insert tool definition is now complete and a preview of the 
insert will be shown.  An insert definition is all that is needed for the 
calculation of toolpaths.  The tool could be used as it is, but we will 
create a holder for the new tool in the next section of this tutorial.
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Adding a tool holder

If you add a holder it will be displayed when the toolpath is previewed 
or simulated, providing a visual clearance check when simulating 
toolpaths.  

Click in the Holder box in the tool list and the Holders dialog will open.

The dialog displays a list of holders that have already been defined.  
If the insert you are using fits an existing holder you can select the 
existing holder and click OK.

We need a new holder for the insert we have just added.
Click the New button to create a new holder.
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 Select the Edit holder check box to activate edit mode.
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Enter the holder name PCLNR 2525 M09.

The third letter of the holder code is the style, so select L = -5 deg 
side (both).

Enter total length 150, head length 24, head width 32, and shank 
width 25.

Select the square shank type and R = right handed.

Select the check box for Show end chamfer, and enter chamfer width 
13 and chamfer length 18.

Click OK to accept the new holder for the current tool.
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The tool preview now shows the insert we created in the previous 
section in the new holder.

Note that the lead angle has been set automatically by the holder 
style.  The holder style lead angle is measured from vertical so an 
insert lead angle of 85 from horizontal is the same as a holder style 
lead angle of -5.
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Create a toolpath using the new tool and simulate it.

You will see the tool simulation using the automatically created holder 
and insert models.

The tutorials in this manual cover the basic elements of OneCNC 
Lathe toolpaths.

For more in-depth tutorials, see the OneCNC Lathe Tutorials in the 
OneCNC Help files.
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For assistance contact the OneCNC office for your location.

If you are emailing a support question, it will help us to help you if 
you zip and attach the file you are having a problem with, and include 
the following information:

Client Number
Click on Help > About OneCNC.  Your client number is a five digit 
number with the prefix CN. The number is the same as your dongle 
number.

Version
Click on Help > About OneCNC to find the exact version you are 
running, e.g. 62.79

OneCNC product
The type and level of OneCNC such as Mill Expert.

Units
Please let us know if the file is drawn in metric or imperial units.

OneCNC Support
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Australia
				   OneCNC Australia

		  Phone 		  +61 (0)7 3286 2527
		  Fax 		  +61 (0)7 3286 4992
		  Email		  support@onecnc.com.au
		  Internet	 www.onecnc.com.au 

Benelux
				   OneCNC Benelux

		  Phone		  +31 (0) 40 22 66 212
		  Fax		  +31 (0) 40 22 40 794
		  Email		  support@onecnc.nl
		  Internet	 www.onecnc.nl 

Denmark
				   OneCNC Denmark

		  Phone		  + 45 20 40 02 68
		  Fax		  + 45 20 40 02 68
		  Email		  support@onecnc.dk
		  Internet	 www.onecnc.dk  

France
				   OneCNC France

		  Phone		  + 33 (0)4 72 33 38 74
		  Fax		  + 33 (0)4 72 91 42 92
		  Email		  support@onecnc.fr
		  Internet	 www.onecnc.fr

Germany
				   OneCNC Germany

		  Phone		  +49(0)5261 288940
		  Fax		  +49(0)5261 2889449
		  Email		  support@onecnc.de
		  Internet	 www.onecnc.de

India
				   OneCNC India

		  Phone		  +61 7 3286 2527
		  Email		  support@onecnc.com.au
		  Internet	 www.onecnc.in

Indonesia
				   OneCNC Indonesia

		  Phone		  +62 31 8411187
		  Email		  support@onecnc.id
		  Internet	 www.onecnc.co.id

OneCNC Global Offices
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Ireland
				   OneCNC Ireland 

		  Phone		  +353 7196 33200
		  Fax		  +353 7196 33500
		  Email		  support@onecnc.co.uk
		  Internet	 www.onecnc.co.uk 

Italy
				   OneCNC Italy

		  Phone		  +39 393 438 3373
		  Fax		  +39 178 271 6215
		  Email		  support@onecnc.it
		  Internet	 www.onecnc.it

Japan
				   OneCNC Japan

		  Phone		  +81 (0)72 760 3134
		  Fax		  +81 (0)72 760 3135
		  Email		  onecnc@onecnc.co.jp
		  Internet	 www.onecnc.co.jp 

Korea
				   OneCNC Korea

		  Phone		  + 82 31 695 7250
		  Fax		  + 82 31 695 7253
		  Email		  support@onecnc.kr
		  Internet	 www.onecnc.kr

Mexico
				   OneCNC Mexico

		  Phone		  +52 (55) 85017429
		  Email		  esanchez@onecnc.com.mx
		  Internet	 www.onecnc.com.mx 

Portugal
				   OneCNC Iberia 

		  Phone		  +34 936 473 117
		  Email		  josep.soler@1cnc.es
		  Internet	 www.onecnc.es

Poland
				   OneCNC Poland

		  Phone		  +48(0)22 388 3460
		  Fax		  +48(0)22 388 3461
		  Email		  support@onecnc.pl
		  Internet	 www.onecnc.pl
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South Africa
				   OneCNC South Africa 

		  Phone		  +27 31 7014732
		  Fax		  +27 31 7014736
		  Email		  sredman@iafrica.com
		  Internet	 www.onecnc.net

Spain
				   OneCNC Iberia 

		  Phone		  +34 936 473 117
		  Email		  josep.soler@1cnc.es
		  Internet	 www.onecnc.es

Sweden
				   OneCNC Sweden

		  Phone		  +46 (0)35-7777030
		  Fax		  +46 (0)35-7777031
		  Email		  support@onecnc.se
		  Internet	 www.onecnc.se

Taiwan
				   OneCNC Taiwan

		  Phone		  + 886 2 26665010
		  Fax		  + 886 2 26660917
		  Email		  chou@wvision.asia
		  Internet	 www.onecnc.com.tw

United Kingdom
				   OneCNC UK

		  Phone 		  +44 (0) 190 237 3054 
		  Fax 		  +44 (0) 190 237 5593
		  Email		  support@onecnc.co.uk
		  Internet	 www.onecnc.co.uk

USA
				   OneCNC LLC

		  Toll Free	 +1 877 626 1262
		  Phone		  +1 813 874 2335
		  Fax		  +1 813 874 2919
		  Email		  support@onecnc.com
		  Internet 	 www.onecnc.com 

USA California
				   OneCNC West

		  Phone		  +1 909 931 7811
		  Fax		  +1 909 985 6967
		  Email		  support@onecncwest.com
		  Internet 	 www.onecncwest.com 
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Copyright Notice

Copyright © 2020     All Rights Reserved 

This publication or parts thereof, may not be reproduced in any form, 
by any method, for any purpose.

Trademarks

The following are registered trademarks of QARM Pty Ltd, in Australia 
and/or other countries: OneCNC XR8, OneCNC XR7, OneCNC XR6, 
OneCNC XR5, OneCNC XR4, OneCNC XR3, OneCNC XR2, OneCNC XR, 
OneCNC XP, OneCNC 2003, OneCNC 2000, OneCNC, AusWire, AusMill, 
AusCAD, AusCADCAM, NCSentry, NCLink.

Third-Party Trademarks

All other brand names, product names or trademarks belong to their 
respective holders.

Copyright Notice
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QARM Pty Ltd. MAKES NO WARRANTY, EITHER EXPRESSED 
OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED 
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE, REGARDING THESE MATERIALS AND MAKES SUCH 
MATERIALS AVAILABLE SOLELY ON AN “AS-IS” BASIS. IN NO 
EVENT SHALL QARM Pty Ltd BE LIABLE TO ANYONE FOR SPECIAL, 
COLLATERAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IN 
CONNECTION WITH OR ARISING OUT OF PURCHASE OR USE OF 
THESE MATERIALS. THE SOLE AND EXCLUSIVE LIABILITY QARM Pty 
Ltd., REGARDLESS OF THE FORM OF ACTION, SHALL NOT EXCEED 
THE PURCHASE PRICE OF THE MATERIALS DESCRIBED HEREIN.

QARM Pty Ltd reserves the right to revise and improve its products as 
it sees fit. This publication describes the state of this product at the 
time of its publication, and may not reflect the product at all times in 
the future.
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